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Appendix 1 : Project Brief

IDE Master Graduation 
Project team, Procedural checks and personal Project brief

IDE TU Delft - E&SA Department /// Graduation project brief  & study overview /// 2018-01 v30 Page 1 of 7

STUDENT DATA & MASTER PROGRAMME
Save this form according the format “IDE Master Graduation Project Brief_familyname_firstname_studentnumber_dd-mm-yyyy”.  
Complete all blue parts of the form and include the approved Project Brief in your Graduation Report as Appendix 1 !

** chair dept. / section:

** mentor dept. / section:

Chair should request the IDE 
Board of Examiners for approval 
of a non-IDE mentor, including a 
motivation letter and c.v..!

!

SUPERVISORY TEAM  **
Fill in the required data for the supervisory team members. Please check the instructions on the right !

Ensure a heterogeneous team. 
In case you wish to include two 
team members from the same 
section, please explain why.

2nd mentor Second mentor only 
applies in case the 
assignment is hosted by 
an external organisation.

!

city:

organisation:

family name

student number

street & no.

phone

email

IDE master(s):

2nd non-IDE master:

individual programme: (give date of approval)

honours programme:

specialisation / annotation:

IPD DfI SPD

!

zipcode & city

initials given name

country:

This document contains the agreements made between student and supervisory team about the student’s IDE Master 
Graduation Project. This document can also include the involvement of an external organisation, however, it does not cover any 
legal employment relationship that the student and the client (might) agree upon. Next to that, this document facilitates the 
required procedural checks. In this document:

• The student defines the team, what he/she is going to do/deliver and how that will come about. 
• SSC E&SA (Shared Service Center, Education & Student Affairs) reports on the student’s registration and study progress.
• IDE’s Board of Examiners confirms if the student is allowed to start the Graduation Project.

- -

comments  
(optional)

country

USE ADOBE ACROBAT READER TO OPEN, EDIT AND SAVE THIS DOCUMENT 
Download again and reopen in case you tried other software, such as Preview (Mac) or a webbrowser.

!

Your master programme (only select the options that apply to you):Aldea 4696

A Anna

5162386

�

Honours Programme Master

Medisign

Tech. in Sustainable Design

Entrepeneurship

Doris Aschenbrenner SDE

Ilse van Zeumeren HCD

Angelique Tinga

SWOV

Den Haag Netherland

Procedural Checks - IDE Master Graduation

Title of Project

Initials & Name Student number

IDE TU Delft - E&SA Department /// Graduation project brief  & study overview /// 2018-01 v30 Page 2 of 7

APPROVAL PROJECT BRIEF
To be filled in by the chair of the supervisory team.

chair date signature

CHECK STUDY PROGRESS
To be filled in by the SSC E&SA (Shared Service Center, Education & Student Affairs), after approval of the project brief by the Chair.  
The study progress will be checked for a 2nd time just before the green light meeting.

NO

List of electives obtained before the third  
semester without approval of the BoE

missing 1st year master courses are:

YES all 1st year master courses passedMaster electives no. of EC accumulated in total:
Of which, taking the conditional requirements 

into account, can be part of the exam programme

EC

EC

• Does the project fit within the (MSc)-programme of 
the student (taking into account, if described, the 
activities done next to the obligatory MSc specific 
courses)? 

• Is the level of the project challenging enough for a 
MSc IDE graduating student? 

• Is the project expected to be doable within 100 
working days/20 weeks ? 

• Does the composition of the supervisory team 
comply with the regulations and fit the assignment ?

FORMAL APPROVAL GRADUATION PROJECT
To be filled in by the Board of Examiners of IDE TU Delft. Please check the supervisory team and study the parts of the brief marked **.  
Next, please assess, (dis)approve and sign this Project Brief, by using the criteria below.

comments

Content: APPROVED NOT APPROVED

Procedure: APPROVED NOT APPROVED

- -

name date signature- -

name date signature- -

Doris Aschenbrenner

Dr.
Doris
Aschen
brenner

Digital
unterschrieben
von Dr. Doris 
Aschenbrenner
Datum:
2021.02.10
14:44:38
+01'00'

18

18

�

J. J. de Bruin 10 02 2021

J. J. de 
Bruin,
SPA

Digitally signed 
by J. J. de 
Bruin, SPA 
Date:
2021.02.10
16:57:05
+01'00'

�

�

- remark: no abbreviation in title, replace HMI with user
interface

Monique von Morgen 16 02 2021

Aldea                                                      4696A 5162386

Virtual Reality for the Evaluation of HMI in Autonomous Vehicles

Appendix 1 Project Brief
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Personal Project Brief - IDE Master GraduationPersonal Project Brief - IDE Master Graduation

Title of Project

Initials & Name Student number

IDE TU Delft - E&SA Department /// Graduation project brief  & study overview /// 2018-01 v30 Page 3 of 7

Please state the title of your graduation project (above) and the start date and end date (below). Keep the title compact and simple.  
Do not use abbreviations. The remainder of this document allows you to define and clarify your graduation project. 

project title

INTRODUCTION **
Please describe, the context of your project, and address the main stakeholders (interests) within this context in a concise yet 
complete manner. Who are involved, what do they value and how do they currently operate within the given context? What are the 
main opportunities and limitations you are currently aware of (cultural- and social norms, resources (time, money,...), technology, ...). 

space available for images / figures on next page

start date - - end date- -

Virtual Reality for the Evaluation of HMI in Autonomous Vehicles

08 02 2021 15 07 2021

In past years we have seen rapid developments in the field of automated transportation. However, there are several 
steps before full vehicle automation. The Society of Automotive Engineers (SAE) has defined six automation levels 
ranging from “no automation” (level 0), where the driver has full control and responsibility of the driving task, to “full 
automation” (level 5), where the driver does not need to be involved at any moment. 
In the process of moving toward full vehicle automation (SAE level 5), there will be a period in which the driving task 
and responsibility will be shared between the driver and the autonomous vehicle (SAE level 2-4). This comes with new 
challenges such as mode confusion, reduced situational awareness, over-reliance and misuse,  which can decrease the 
driver’s performance ability and lead to an unsafe driving experience. 
 
The MEDIATOR project, led by SWOV, the Dutch Institute of Road Safety Research, aims to tackle these issues through 
the development of an intelligent system that mediates the transition of control between the human driver and the 
autonomous vehicle. The mediating system will assess who is fittest to drive based on the driving context, the driver’s 
state and the vehicle automation status.  
 
The MEDIATOR project approaches the different levels of vehicle automation from a human-centred perspective, 
defining three driving modes: “Continuous Mediation” (CM) refers to the lowest levels of automation (SAE level 1-2), 
during which the driver is assisted in the driving task but must be alert at all times. “Driver in Stand By” (SB) is consistent 
with automation levels (SAE level 3-4) during which the automation can reliably take-over control for short periods of 
time.  In these moments the driver can perform secondary tasks but must be ready to take-over the driving task on 
short notice. Finally, “Time to Sleep” (TtS) is a higher automation level (SAE level 4), which allows the driver to dedicate 
longer periods of time to other activities before he will be asked to take-over control of the vehicle. 
 
The Human-Machine Interface (HMI) plays an important role in guaranteeing a pleasant user experience, as well as the 
safe and comfortable transition between driving states. Several HMI concepts are being developed within the 
MEDIATOR project. In order to converge towards a final HMI prototype, the concepts must be evaluated and iterated 
on. In this iterative process arises a need for a tool that can facilitate the testing process of the different HMI 
components in a rapid and reliable manner.  
Virtual Reality (VR) provides an opportunity in the area of design evaluation, as it allows designers to rapidly implement 
digital prototypes in an immersive virtual environment, in which participants can interact with the different design 
elements.  

Aldea                                                      4696A 5162386

Virtual Reality for the Evaluation of HMI in Autonomous Vehicles

Personal Project Brief - IDE Master GraduationPersonal Project Brief - IDE Master Graduation

Title of Project

Initials & Name Student number

IDE TU Delft - E&SA Department /// Graduation project brief  & study overview /// 2018-01 v30 Page 4 of 7

introduction (continued): space for images

image / figure 2:

image / figure 1: Current and Desired Situation

Envisioned Solution Space
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Personal Project Brief - IDE Master GraduationPersonal Project Brief - IDE Master Graduation

Title of Project

Initials & Name Student number

IDE TU Delft - E&SA Department /// Graduation project brief  & study overview /// 2018-01 v30 Page 5 of 7

PROBLEM DEFINITION  **
Limit and define the scope and solution space of your project to one that is manageable within one Master Graduation Project of 30 
EC (= 20 full time weeks or 100 working days) and clearly indicate what issue(s) should be addressed in this project.

ASSIGNMENT **
State in 2 or 3 sentences what you are going to research, design, create and / or generate, that will solve (part of) the issue(s) pointed 
out in “problem definition”. Then illustrate this assignment by indicating what kind of solution you expect and / or aim to deliver, for 
instance: a product, a product-service combination, a strategy illustrated through product or product-service combination ideas, ... . In 
case of a Specialisation and/or Annotation, make sure the assignment reflects this/these.

Within the MEDIATOR project, a holistic HMI is being developed, which is multimodal and involves several parts of the 
vehicle’s interior. In order to properly evaluate the different HMI elements, participants should experience a realistic 
usage scenario and be immersed in the context. As it is difficult to bring the evaluation of the HMI on the road in the 
initial evaluation stages, an alternative solution is needed. Simulating the context (interior of the vehicle) and situation 
(traffic conditions) in a Virtual Reality environment provides an opportunity for testing HMI elements in context and as 
a holistic design, rather than as separate elements. 
 
Implementing designs in a VR environment allows for a rapid evaluation of HMI concepts, without the need to 
construct physical interactive prototypes, which takes more time and effort. Therefore, more concept iterations can 
also be tested and compared during the design process. Furthermore, using VR as a tool for evaluating user experience 
provides clear advantages compared to other digital evaluation methods that are currently used, such as animations 
which simulate a usage scenario. In a virtual environment, participants have a more immersive experience, as the 
entire interior of the car and several elements of the HMI can be simulated at once. 
By creating a tool which allows researchers to test their designs in the context, simulated through VR, I can aid them in 
conducting quick and reliable experiments. 
 
With the development of more capable and cheaper headsets, VR technology is becoming more accessible for 
applications in various fields, including design. Game development platforms such as Unity 3D and the available 
resources allow designers to create VR applications quickly and even with minimal coding knowledge. Digital 
prototyping also allows for a quick iterative process as applications can easily be improved upon and adjusted without 
the need to create an entirely new prototype. 

The goal of this project is to facilitate the design evaluation process of existing and new HMI designs created within the 
MEDIATOR project, through the use of Virtual Reality. A VR tool will be developed, aiming to simulate a realistic use 
context and capture a holistic user experience.

After researching the specific requirements for the testing of the HMI elements within the context of the MEDIATOR 
project as well as the advantages and limitations of using VR for conducting design evaluation, I aim to create a VR tool 
that will facilitate researchers and designers in this process. 
Using Unity 3D a virtual reality environment simulating the interior of a vehicle will be created, inside which different 
existing HMI designs can be easily implemented and tested by the research team. A solution could be to create a 
modular model of the vehicle, in which different parts of the interior can be changed to include various elements of 
the HMI, as needed. In this process, small adjustments could be made to the existing elements with regards to their 
position in the vehicle and lighting. 
Furthermore, I will explore how this VR tool can be easily adopted by the MEDIATOR research and design teams and, if 
needed, develop supporting materials, such as a usage guide. 
 
This solution will allow researchers and designers to evaluate existing HMI concepts in a rapid and effective manner 
and gain valuable insights about the use of designs in context, which will contribute to the further development of the 
HMI. 
 

Aldea                                                      4696A 5162386

Virtual Reality for the Evaluation of HMI in Autonomous Vehicles

Personal Project Brief - IDE Master GraduationPersonal Project Brief - IDE Master Graduation

Title of Project

Initials & Name Student number
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PLANNING AND APPROACH **
Include a Gantt Chart (replace the example below - more examples can be found in Manual 2) that shows the different phases of your 
project, deliverables you have in mind, meetings, and how you plan to spend your time. Please note that all activities should fit within 
the given net time of 30 EC = 20 full time weeks or 100 working days, and your planning should include a kick-off meeting, mid-term 
meeting, green light meeting and graduation ceremony. Illustrate your Gantt Chart by, for instance, explaining your approach, and 
please indicate periods of part-time activities and/or periods of not spending time on your graduation project, if any, for instance 
because of holidays or parallel activities. 

start date - - end date- -8 2 2021 15 7 2021

This project will be structured based on the Double Diamond model and devised into four stages of research and 
design: 
 
Discover: The first phase of the assignment will be focused on research and understanding the context in which the 
evaluation tool will be used and its requirements, as well as exploring the possibilities and limitations of using VR as a 
tool for design evaluation. 
 
Define: In the second phase I will define the challenges and frame the areas of opportunity, converging towards a final 
concept that meets the requirements of the stakeholders. A list of requirements for the final design will be created in 
this stage. 
 
Develop: Based on the initial findings I will start iterating on the design through the use of MVP (Minimal Viable 
Product) which will be tested in order to identify requirements and points of improvement. Results of the initial tests 
will inform the previous phase and help define the scope of the project. 
 
Deliver: In the final phase the VR environment will be improved and evaluated with the main stakeholders. 
 
Finally, the results of the four stages will be synthesized in the graduation thesis. 
 

Aldea                                                      4696A 5162386

Virtual Reality for the Evaluation of HMI in Autonomous Vehicles
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Personal Project Brief - IDE Master Graduation

Title of Project

Initials & Name Student number

IDE TU Delft - E&SA Department /// Graduation project brief  & study overview /// 2018-01 v30 Page 7 of 7

MOTIVATION AND PERSONAL AMBITIONS
Explain why you set up this project, what competences you want to prove and learn. For example: acquired competences from your 
MSc programme, the elective semester, extra-curricular activities (etc.) and point out the competences you have yet developed. 
Optionally, describe which personal learning ambitions you explicitly want to address in this project, on top of the learning objectives 
of the Graduation Project, such as: in depth knowledge a on specific subject, broadening your competences or experimenting with a 
specific tool and/or methodology, ... . Stick to no more than five ambitions.

FINAL COMMENTS
In case your project brief needs final comments, please add any information you think is relevant. 

My interest in tackling this project stems from the topic’s relevance and complexity, which makes the design process 
both engaging and challenging. 
By conducting this project I aim to prove the research and conceptualization abilities that I have  acquired thus far, but 
also to improve my prototyping and evaluation skills. 
 
Interactive prototyping and Virtual Reality development are skills that I am personally interested in learning, as I believe 
they are a good addition to an interaction designer’s skill set. During the past years I have had the opportunity to 
develop a number of interactive prototypes and experiment with tools such as Unity and I look forward to continuing 
on this path. 
 
During the course of my studies at the TUDelft I have regretted not having been able to perfect my evaluation skills. 
This was mainly due to the unexpected lock-down, which reduced our chances of conducting user tests face to face 
and/or in context. In this project, I aim to create a more professional evaluation set-up and improve my ability. 
 
Despite the ongoing restrictions caused by COVID-19,  I am confident that, with the support of fellow graduating 
students and my supervisory team, I can overcome the challenges, both personal and related to the project, that 
might arise during this time.

Aldea                                                      4696A 5162386

Virtual Reality for the Evaluation of HMI in Autonomous Vehicles
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Appendix 2 : VR Evaluation Forms

VR EVALUATION SETUP FORM 

Mediator HMI concept:

Concept description:

Research Question(s):

Goal of the evaluation:

In the following section include a visualisation of the design(s).

Mediator HMI concept:

User:

Context:

Please describe the task(s) that participants must perform during the 
evaluation. What is the goal of each task? 
What are the needs of the user when interacting with the prototype?

Please describe the context of use and environment in which the 
design will be used. 
Which contextual and environmental aspects can affect the 
experience and interaction with the prototype?

Data: What type of data and information must be collected for the 
evaluation of the design(s)? 

Mediator HMI concept:

This form was used to structure insights regarding the 
requirements for the evaluation of the Mediator HMI us-
ing a VR prototype.

The forms were completed following an interview with 
the designer of the HMI, and used as a reference for the 
ideation of MVP1 and MVP2.

Appendix 2 VR Evaluation Forms
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Appendix 3 : MVP 1 Evaluation
                        Materials

For the evaluation of MVP1 participants were asked to 
answer both questions related to the HMI design, after 
each scene, and their experience with the VR application, 
after completing the experiment. 

Appendix 3 MVP1 Evaluation Materials
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Appendix 4 : MVP 2 User Guide

Appendix 4 MVP2 User Guide
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Appendix 5 : MVP 2 Evaluation
       Materials

In the following pages, questions marked with P1 refer 
to those posed to Participant 1, the mediator designer. 
Questions marked with P2 were aswered bu the test par-
ticipant.

Mediator HMI VR Evaluation

Evaluation MVP 2 | HMI Instrument panel + ambience
Scenario: UC1 - Forced takeover

Evaluation Set-up:
Participant 1 (Mediator designer/researcher)

Activities (2h):         - Setting up VR scenario in Unity 3D
- Conducting experiment with participant 2 +

collecting data
Materials:                 - Instructions for VR tool
Goal: - Evaluating the use the VR tool by designers

Participant 2 (test participant)
Activities (1h):          - Experiencing HMI through VR
Goal: - Evaluating the experience with VR (presence)

- Evaluating the performance of the VR tool
- Evaluating the experience with the HMI

P1:
Procedure

Introduction of the VR tool: The researcher is introduced to the VR
tool and given an explanation of the elements and how they can be
modified (timeline).
Scenario set-up: The researcher is asked to modify a scenario, using
pre-existing animations.
Questionnaire Related to the ease of use of the: The researcher is
asked to evaluate the ease of use and flexibility of the VR tool (and
instructions?).

Appendix 4 MVP2 Evaluation Materials
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P1 Questionnaire:
1. Did you perceive the Unity editor to be intuitive and easy to use?

a. Why or why not?

2. Were you able to perform the required tasks?
a. Did you encounter any issues when doing so?

b. What were the issues related to?

3. Do you believe you could easily learn to use the Unity editor to apply changes to a
scenario using pre-existing animations?

4. Did the provided instruction help you in performing the tasks?

5. Were the instructions sufficient and would you have been able to perform the
tasks with no additional help?

1. What other modifications would you like to apply to the timeline when
constructing a custom evaluation scene?

2. Would you like to have control over the single animation clips?

3. Would you like to be able to construct animation clips instead of using predefined
ones?

P2 HMI evaluation Questions:
Please rate your experience with the Mediator HMI.

1. During the experienced scenario, how clear was the information given to
you through the instrument panel/screen?

1. The
information
was not clear at
all

5. The
information
was always
clear.

2. During the experienced scenario, how clear was the information given to
you through the ambient lighting?

1. The
information
was not clear at
all

5. The
information
was always
clear.

3. During the experienced scenario, how clear was the information given to
you through the dashboard LED strip?

1. The
information
was not clear at
all

5. The
information
was always
clear.

4. During the experienced scenario, how clear was the information given to
you through the gear lever?

1. The
information
was not clear at
all

5. The
information
was always
clear.

5. During the experienced scenario, how clear was the information given to
you through the holistic HMI (all of the HMI components together)?

1. The
information
was not clear at
all

5. The
information
was always
clear.

6. During the experienced scenario, were you ever confused about the
current driving mode?

1. I never
understood
what the
current driving
mode was.

5. I always
understood
what the
current driving
mode was.

Appendix 5 MVP2 Evaluation Materials
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a. Through which HMI component(s) was the driving mode
communicated to you?

7. During the experienced scenario, were you always aware of the time left in
the current driving mode?

1. I was never
aware of the
time budget
left before a
switch to the
next driving
mode.

5. I was always
aware of the
time budget
left before a
switch to the
next driving
mode.

a. Through which HMI component(s) was the time left in the current
driving mode communicated to you?

8. During the experienced scenario, did you understand how much control
you had over the vehicle and were you aware of the actions (driving related
tasks) you were expected to perform?

1. I did not know
if I had control
over the vehicle
and what
action I was
expected to
perform.

5. I was always
aware of how
much control I
had over the
vehicle and
what actions I
was expected
to perform.

Questions related to the information on the instrument panel screen:
9. When given the first alert on the instrument panel screen, did you

understand that the system initiated a take over request?

10. Did you understand the reason for the system’s take over request?

11. When the system initiated the takeover request, did you understand the
information that was related to you?

a. Was it clear what driving mode the system would switch to?

b. Were the icons present on the screen able to convey information
related to the current and next driving modes?

c. Was it clear that you could manually confirm the takeover request
and how you could do so?

12. After confirming the takeover, was it clear to you that the takeover had not
yet happened and a small time frame remained in which you were
expected to maintain control of the vehicle?

a. Was the information about the time budget left until the take over
clearly conveyed?

13. After the takeover was completed, was it clear to you that you no longer
had control over the vehicle and could let go of the steering wheel?

Questions related to the information given by LED strip, ambient lighting:

14. Did the information related by the LED strip and ambient lighting in the
vehicle support your understanding of the current driving mode and
imminent transfer of control?

a. Did the lighting animations (pulsating) attract your attention
towards the information given on the screen?

b. Did the lighting animations inspire a sense of urgency to act during
the transfer of control request?

c. Did the lighting animations clearly communicate when a transfer of
control was happening and/or when a transfer to a different driving
mode was completed?

Appendix 5 MVP2 Evaluation Materials
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Additional open questions:

15. In your opinion, how could the information related by the HMI be
improved?

16. Is there any additional information that you would have liked to be given by
the HMI during the experienced scenario?

VR related evaluation (P2):

SUS Questionnaire:
1. Please rate your sense of being in the virtual environment, on a scale of 1 to 7,
where 7 represents your normal experience of being in a place.

1 2 3 4 5 6 7

O O O O O O O

2. To what extent were there times during the experience when the virtual
environment (the interior of the vehicle) was the reality for you?

1: At no time - 7: Almost all of the time
1 2 3 4 5 6 7

O O O O O O O
3. When you think back to the experience, do you think of the interior of the
vehicle more as images that you saw or more as somewhere that you visited?

1: The vehicle felt like images that I saw - 7: The vehicle felt like a place that I visited
1 2 3 4 5 6 7

O O O O O O O

4. During the time of the experience, which was the strongest on the whole, your
sense of being in the vehicle or of being elsewhere?

1: I felt like being somewhere else - 7: I felt like being in the vehicle
1 2 3 4 5 6 7

O O O O O O O

5. Consider your memory of being in the virtual environment. How similar in terms
of the structure of the memory is this to the structure of the memory of other
places you have been today? By ‘structure of the memory’ consider things like the
extent to which you have a visual memory of the virtual environment, whether that
memory is in colour, the extent to which the memory seems vivid or realistic, its
size, location in your imagination, the extent to which it is panoramic in your
imagination, and other such structural elements.
My memory of the interior of the vehicle is similar to that of other places I have
visited today:

1: Not at all - 7: It is very similar
1 2 3 4 5 6 7

O O O O O O O

6. During the time of your experience, did you often think to yourself that you were
actually in the vehicle?

1: Not at all - 7: Very often
1 2 3 4 5 6 7

O O O O O O O

Additional open questions:
7.  In your opinion, what could have improved your feeling of being in the interior of
the vehicle?

8. Which elements in the environment/events experienced have made feel like you
were not actually in the vehicle?

Appendix 5 MVP2 Evaluation Materials
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Appendix 6 : MVP 3 Evaluation
       Materials

Appendix 6 MVP3 Evaluation Materials

SUS Questionnaire:
1. Please rate your sense of being in the virtual environment, on a scale of 1 to 7,
where 7 represents your normal experience of being in a place.

1 2 3 4 5 6 7

O O O O O O O

2. To what extent were there times during the experience when the virtual
environment (the interior of the vehicle) was the reality for you?

1: At no time - 7: Almost all of the time
1 2 3 4 5 6 7

O O O O O O O

3. When you think back to the experience, do you think of the interior of the
vehicle more as images that you saw or more as somewhere that you visited?

1: The vehicle felt like images that I saw - 7: The vehicle felt like a place that I visited
1 2 3 4 5 6 7

O O O O O O O

4. During the time of the experience, which was the strongest on the whole, your
sense of being in the vehicle or of being elsewhere?

1: I felt like being somewhere else - 7: I felt like being in the vehicle
1 2 3 4 5 6 7

O O O O O O O

5. Consider your memory of being in the virtual environment. How similar in terms
of the structure of the memory is this to the structure of the memory of other
places you have been today? By ‘structure of the memory’ consider things like the
extent to which you have a visual memory of the virtual environment, whether that
memory is in colour, the extent to which the memory seems vivid or realistic, its
size, location in your imagination, the extent to which it is panoramic in your
imagination, and other such structural elements.
My memory of the interior of the vehicle is similar to that of other places I have
visited today:

1: Not at all - 7: It is very similar
1 2 3 4 5 6 7

O O O O O O O

6. During the time of your experience, did you often think to yourself that you were
actually in the vehicle?

1: Not at all - 7: Very often

1 2 3 4 5 6 7

O O O O O O O

Additional open questions:
7.  In your opinion, what could have improved your feeling of being in the interior of
the vehicle?

8. Which elements in the environment/events experienced have made you feel like
you were not actually in the vehicle?

9. Did you experience the interaction with the virtual objects as being natural? If
not, what made the experience unnatural?

SUS Questionnaire:
1. Please rate your sense of being in the virtual environment, on a scale of 1 to 7,
where 7 represents your normal experience of being in a place.

1 2 3 4 5 6 7

O O O O O O O

2. To what extent were there times during the experience when the virtual
environment (the interior of the vehicle) was the reality for you?

1: At no time - 7: Almost all of the time
1 2 3 4 5 6 7

O O O O O O O

3. When you think back to the experience, do you think of the interior of the
vehicle more as images that you saw or more as somewhere that you visited?

1: The vehicle felt like images that I saw - 7: The vehicle felt like a place that I visited
1 2 3 4 5 6 7

O O O O O O O

4. During the time of the experience, which was the strongest on the whole, your
sense of being in the vehicle or of being elsewhere?

1: I felt like being somewhere else - 7: I felt like being in the vehicle
1 2 3 4 5 6 7

O O O O O O O

5. Consider your memory of being in the virtual environment. How similar in terms
of the structure of the memory is this to the structure of the memory of other
places you have been today? By ‘structure of the memory’ consider things like the
extent to which you have a visual memory of the virtual environment, whether that
memory is in colour, the extent to which the memory seems vivid or realistic, its
size, location in your imagination, the extent to which it is panoramic in your
imagination, and other such structural elements.
My memory of the interior of the vehicle is similar to that of other places I have
visited today:

1: Not at all - 7: It is very similar
1 2 3 4 5 6 7

O O O O O O O

6. During the time of your experience, did you often think to yourself that you were
actually in the vehicle?

1: Not at all - 7: Very often
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p. 1

Mediator VR Evaluation Tool

User Manual

Author: 
Anna Aldea

A step-by-step guide custom evaluation scenes 
using Unity Game Engine

The manual is designed to help users in navigating the 
Unity project of the Mediator VR tool. 

The content of the User Manual is included entirely in 
the following pages.
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Glossary

In this User Manual the terms defined below, which are specific to the Unity Game 
Engine, will be used.

For more information on terms in the Unity editor, you can consult the following 
link: https://docs.unity3d.com/Manual/Glossary.html#SectionCore

GameObject / Object: Any object found in a Scene, which can 
represent characters, props, scenery, cameras, waypoints, and more. 
A GameObject’s functionality is defined by the Components attached 
to it. 
https://docs.unity3d.com/Manual/GameObjects.html

Asset: Any media or data that can be used in the project. Assets are 
stored in the Project folder.

Prefab: An asset type which acts as a container of a GameObject, 
complete with components and properties. 
https://docs.unity3d.com/Manual/Prefabs.html

Scene: Assets which contain all of the environments and elements 
of an application. Each scene represents a unique “level”. Application 
can be simple, containing a single scene, or be more complex, with 
multiple scenes or “levels”. 
https://docs.unity3d.com/Manual/CreatingScenes.html

Build / Building: The process of compiling your project into a format 
that is ready to run on a specific platform or platforms. 
https://docs.unity3d.com/Manual/BuildSettings.html
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Introducing The Mediator 
VR Evaluation Tool

The Mediator VR Evaluation Tool has been developed using the Unity 3D Game 
Engine. 

GENERAL INFORMATION

• The tool was created using Unity version 2020.6.6f1.

• The XR Interaction Toolkit package is used in this project. It is an 
interaction system which provides a framework for various VR interaction 
tasks and cross-platform support. ( https://docs.unity3d.com/Packages/com.
unity.xr.interaction.toolkit@1.0/manual/index.html )

• This project was built for and test on both HTC Vive and Oculus Quest 
platforms.

Unity 3D Interface

Prefabs 

Unity Timeline

An overview of Unity’s interfaces and the various 
windows and tools used for this project.

A list of prefabs created for the Mediator VR Evaluation 
Tool, explaining how they are made and how they 
sould be used.

An overview of the Unity Timeline and its functionality. 
Essential to understanding how to create your own 
custom scenarios.

In order to set-up custom experiments using the tool, you will need to learn how to 
navigate the Unity Interface and use the various assets and scripts included in the 
project.

This User Manual will guide you step-by-step in creating and building your own 
evaluation scene (see Section 2). But first, we will introduce the main elements of 
the VR Evaluation Tool.
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Unity 3D Interface

Layout of 
the Unity, as 
arranged for 
the Mediator 
VR tool.

More 
information 
on the 
Timeline 
editor is 
found on 
page 20.

When opening the main editor window of Unity, you will notice that the interface of 
Unity 3D is made up of small windows, as shown in the image below.

Note that the windows can be rearranged or grouped in one position. To view 
hidden windows you must click on their name at the top of the window, as shown in 
the image with the Animation window.

Animation window
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Scene View
The Scene View allows us to view and navigate the 
tridimensional scene that we have created. When a 
visual element is added to scene, it will become visible 
and can be moved and rotated in the desired position.
https://docs.unity3d.com/Manual/UsingTheSceneView.
html

Hierarchy Window
The Hierarchy Window contains all object available in 
the scene, grouped in a hierarchical representation. 
In the Hierarchy, we find the Scene, as “parent object” 
containing everything else. 
https://docs.unity3d.com/Manual/Hierarchy.html

Inspector Window
The Inspector allows us to inspect and analyse all 
the editable properties of an object, that is selected 
in the Hierarchy. Different objects have specific sets 
of properties (e.g. a transform component, colliders, 
mesh renderes, scripts and many more) When an 
object in the Hierarchy or project folder is selected, 
the inspector window will show all the available 
information about it, with the properties available for 
editing.
https://docs.unity3d.com/Manual/UsingTheInspector.
html

Project Folder
In the project folder we finds the library of assets 
and packages which are used in the project. These 
include all scenes, scripts, prefab objects, animations, 
images, audio files and other additional files that are 
implemented in the project.
Everything that needs to be accessed in the project file 
can be found here.
https://docs.unity3d.com/Manual/ProjectView.html

Scenes Folder in the Project window.

Information displayed for a 
selected object in the Scene, 
Hierarchy and Inspector 
windows.

Mediator HMI prefab assets in the Project window.

The image above shows the relationship between the Scene, Hierarchy and 
Inspector. The selected object, The “HMI Wheel”, is shown with a translation 
gizmo (arrows) in the Scene View, indicating that is can be moved. In the Inspector 
windows, the editable properties of the object are now visible. Variables that are 
modified in the Inspector window will be visible in the Scene view. For example 
changing the value related to the position of the object in the “transform” 
component, will move the object to a new location in the scene.
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Prefabs

In order to simplify the task of creating custom scenes for the evaluation of the 
Mediator HMI designs, a number of prefabs were created, which are ready to be 
added to the scenes and used.

Prefab assets are a special type of component that allows fully configured 
GameObjects to be saved in the Project for reuse. These assets can then be shared 
between scenes, or even other projects without having to be configured again.

For more information on the Unity prefabs system you can access the Unity Manual: 
https://docs.unity3d.com/Manual/Prefabs.html

In the following section, we will give an overview of the main prefabs created for the 
Mediator HMI and their characteristics.

When added to the Hierarchy 
window, prefab objects are 
displayed in blue.

System Prefabs
The project contains a number of prefabs that are essential to the working of 
the VR application and to the management of the scenes. The majority of these 
components do not contain any visual elements, but must be added to the 
Hierarchy to insure that the application will run smoothly.

The following lists detail the necessary and optional system prefabs:

Necessary:
XR Rig: This component allows the 
player to see, move and interact with 
the virtual scene. It contains the Main 
camera, which moves with the player’s 
head, and hand avatars which follow 
the movement and input of the VR 
controller. 

XR Interaction Manager: This 
component manages the interactions 
perform in VR and is related to the XR 
Interaction Toolkit, used in the project.

Level Loader: This component 
contains a custom script, which allows 
researchers to remotely load new scenes 
during the evaluation through the use of 
a remote keyboard.

Post Processing: This component 
defines the post processing effects 
rendered on the Scene.

Optional:
Environment Sphere: This prefab is an 
inverted share onto which 360° images 
of road environments are displayed, to 
recreate the feeling of being on the road. 
This component can be added when 
displaying an exterior environment is 
desired for the experiment that will be 
conducted.

Timeline Controller - Wizard of OZ: 
This component contains a custom script 
which allows users to play or pause 
timelines in the scene remotely during 
the evaluation moment, by attaching 
a list of keyboard keys to the list of 
timelines in the scene.

Timeline Control - Master Timeline: 
This component shows an example of 
how a master timeline asset can be set 
up to combine different timelines in a 
scenario or simply display them in the 
desired order. This prefab can de added 
to the scene, packed and modified or 
referenced as an example for creating a 
custom master timeline.

More information about these prefabs is given in section two of this User Manual 
and in the related video tutorials.
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HMI Prefabs
The Mediator VR Evaluation Tool Unity project includes five Prefab Objects related 
to the varios Mediato HMI components.
Each of this objects is constructed to recreate the look and behavior they would 
exhibit in real life. The objects are animated and have a variety of existing animation 
clips, which are combined to simulate different behaviours.

The HMI Wheel and HMI Gear Lever prefabs both contain interactable 
components (part of the XR Interaction Toolkit), which allow users to interact with 
the objects in VR, by grabing and moving them with their hands.

Head-Up-Display (HUD)

Screen

LED strips

Wheel
Gear Lever
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HMI HUD (Head-Up-Display)HMI Screen

“Centre” “GPS” “Media”

The HMI screen prefab 
is built using Unity’s UI 
elements. A UI Canvas 
component, the HMI_
instrumentCanvas, holds 
three different images 
which represent various 
parts of the screen: the 
instrument panel, called 
Centre; the GPS; the 
Media display. 

Each of these 
components is animated 
to display different 
frames, representing the 
changes in the Mediator 
screen’s UI in different use 
cases.

The HMI_instrumentCanvas, 
holds three image 

components: Centre, GPS 
and Media.

In the Hierarchy the Centre 
component, which is a child 
of the HMI_instrumentCan-

vas, is selected. 
In the inspector, we can see 
the image which is currently 

applied to the component.

The HUD component has a 
canvas and a single Image 
component.

The HMI Head-Up-Display prefab 
is built in the same way as the HMI 
screen prefab, shown on the previous 
page. In this case, the UI Canvas, 
HMI_HUDCanvas, only has one image 
component, Image.

Note: The HMI_HUDCanvas and 
HMI_instrumentCanvas are both set 
to be rendered in World Space. As 
such, they must have an Event 
Camera attached. This will be the 
camera though which we can view 
the images in the canvas. As shown 
in the image on the left, our main 
camera is a child of the XR Rig.

If you are not able 
to view the UI 
elements in your 
scene, check that 
the two canvas 
components; Event 
Camera is set up 
correctly.

The image shows the 
relationship between the 
Event Camera variable of 
the Canvas component, 
HMI_HUDCanvas, shown in 
the Inspector and the Main 
Camera object, which is a 
child of the XR Rig, seen in 
the Hierarchy view.
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HMI LED

The HMI LED prefab is a simple object, containing a low number of elements: the 
Dashboard LED strip and two LED strips placed underneath the foot compartment, 
which create Ambient lighting.

These two child objects are animated to recreate the behaviour of the Mediator 
lighting design. Because they can exhibit small differences in the way the behave, 
for example, the Dashboard LED can decrease and increase in length to represent 
time budget, they are animated separately. Each child has its own Animator 
component, as shown in the images below.

HMI Wheel

The HMI Wheel has several 
children objects, as seen 

in the Hierarchy view. The 
Mediator _logo and Wheel 
LED Strip components can 

be activated or deactivated 
by ticking the box 

highlighted in the Inspector 
window.

The components which 
define the physical 

intraction with the wheel, 
highlighted in orange, 

should not be modified.

The HMI Wheel prefab 
contains two children 
objects that are part of 
the lighting design of 
the Mediator HMI: the 
Mediator logo and the 
wheel LED strip. These are 
part of the wheel object, 
rather than the HMI LED 
prefab, as they must 
follow the movement of 
the wheel.

If one of these elements is 
not necessary in the scene, they can be deactivated 
from the Inspector window as shown in the image on 
the right.

The HMI Wheel prefab is an object that users can 
interact with, grabbing (by pressing a button on each 
VR controller, as explained in section 2.5) and rotating 
it. This interaction is made possible though four Grab 
Intractable components, that are part of the XR 
Interaction Toolkit.

Compared to other HMI 
prefabs, the HMI LED 
prefab has two child 

objects which are animated 
separately.
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HMI Gear Lever
The HMI Gear Lever prefab is an 
intractable object. Similarly to the HMI 
Wheel, it can be grabbed and moved 
through a Grab Interactable component. 
This object allows extra functionality, 
as it can be set up to automatically play 
Timeline assets when the user moves 
the gear into one of the four positions.

The four positions (NeutraL, Manual, 
Assisted and Piloted) are defined by 
four Socket Interactable components, 
also part of the XR Interaction Toolkit. 
These are invisible objects which 
allow an object, in this case the gear, 
to snap into a predefined position. 
This interaction will activate a number of 

events, which can be seen 
in the Inspector window 
under the XR Socket 
Interactor’s Interactor 
Events lists. The Select 
event, is activated when 
the gear lever is snapped 
into the specific Socket. 

The gear lever can snap into four different 
positions. Using the Socket Interactor events, 
moving the gear into one of the positions 
can become a trigger for an action, such as 
playing a Timeline asset.

In order to automatically play a Timeline through the interaction with the gear lever, 
an event can be added to the Select list, as shown in the previous image.

To set up the event we can drag in the object we wish to control from the 
Hierarchy view. Then, we can select one of the existing functions available for 
the object. In the image below we can see how to set up the Play() function of on 
object with a Playable Director component.

GEAR STARTING POSITION

The Gear Lever prefab has a custom script attached to it called Gear Lever 
Positioner, see image below. This scrips allows us to define the position in which 
the gear will be at the start of our Scene.
For example, if our evaluation scenario starts with the vehicle driving in assisted 
more, we can tick the Gear in Assisted variable. When the scene starts, the gear 
lever will be in the correct position. 

Set up the starting position of the HMI Gear Lever object by ticking ne of the variables. 

An example for how to play 
a Timeline asset using the 
Socket Interactor events.

Several functions can be 
set to execute when the 
interaction with the Gear is 
performed.
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Unity Timeline

Unity Timeline (https://docs.unity3d.com/Packages/com.unity.timeline@1.2/manual/
tl_about.html) is a tool that allows us to create complex scenarios by managing 
the objects in the scene. With the timeline, we have the ability to control 
animations and position them in time, but also to activate/deactivate objects 
and perform specific events on the time axis. 
The Timeline is an important piece of the Mediator VR Evaluation Tool, as it is used 
to synchronise animations associated with different Mediator driving modes and 
Use Case scenarios, recreating the HMI behaviour in each of these situations.
In order to create custom scenes for an evaluation of the HMI, it is important to 
have a basic understanding of the Timeline and each of its tracks. 

Similarly to video editing software, in the Timeline editor window we can add 
various components called tracks. Different types of tracks can be used for 
different purposes:

TIMELINE TRACKS
• Animation tracks: Use Animation tracks to add Animation clips that animate a 

bound object in the scene.
• Activation tracks: Use Activation tracks to add Activation clips which set when 

the bound object is active (shown). The object is bound to the Activation track.
• Audio tracks: Use Audio tracks to add Audio clips for playing background music 

or sound effects.
• Control tracks: Use Control tracks to add Control clips which are special clips 

that control different object in the scene, including other Timelines.

Example of Timeline tracks. From top to bottom: animation track, activation track, audio track 
and control track.

Controls

Timeline Track
Recorded Clip

Clips

NAVIGATING THE TIMELINE WINDOW

Events created with the Unity Timeline can be previewed directly in Unity’s Scene 
view by using the controls on the top left corner of the Timeline editor. When the 
“preview” button is toggled on the timeline can be played and paused.

Timeline tracks are displayed in the track list. Each track in a timeline can contain 
multiple clips (e.g. animation clips, audio clips) and is linked to an object that exists 
in the scene. These links are referred to as bindings. 

Note: When an existing Timeline asset is added to a Scene, it is important 
to recreate the bindings between the tracks and the correct objects (see 
image below). An exception to this is the audio track. While audio tracks can be 
linked to an audio source in the Hierarchy, these are not necessary.

Creating bindings between tracks and objects in the scene. 
On the left, we can see the relationship between the a track and an object in the 
hierarchy window. In order to link the track to the binding we can click the icon next to 
the track name and choose between the components available in the scene (right).

Overview of the Timeline editor window.
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Creating a Custom Scene 
with the Mediator VR 
Evaluation Tool

Follow the steps presented in this chapter to easily create a custom scene to 
use in your experiment for the Mediator HMI. 

You will be guided through the process step-by-step, from creating a new scene, to 
creating a custom scenario by modifying the contents of the scene. Finally, you will 
be given tips for how to prepare for an evaluation using  the Mediator VR Evaluation 
Tool.

Remember to consult the previous section of this User Manual for more information 
on the characteristics of the HMI prefabs and the Unity Timeline.

A number of video tutorials have ben crated to explain to demonstrate the actions 
you can or must take in some steps. Watch these if you need more information 
to complete one of the steps.

1
Creating a New Scene

Create a Scene that you can customize by either:
1. Duplicating the Sample Scene, containing all necessary 

objects.
2. Creating a new Scene and adding in all the necessary objects.

5
Using the VR tool During the Evaluation 
Moment

Follow these instructions to prepare test participants for the 
experience using a VR device and to control the application 
remotely using keyboard inputs.

Build the Scene or Scenes that you created. Set up the keybord 
controls required to start your scenes during the evaluation.

4
Building Evaluation Scenes

3
Using the Unity Timeline

Create a scenario by including in your scene one of the existing 
Timeline assets. Choose one of two methods to play various 
Timelines throughout your expeeriment. Modify Timelines as 
desired.

2
Customising Scene Content

Customize your Scene by making the desired changes to the 
objects. You can add or remove objects, or change their size, 
position and appearance.
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1. DUPLICATING THE SAMPLE SCENE

To create your custom scene you can start by 
duplicating the existing “Sample Scene”, which can be 
found in the Project Folder: Project > Assets > Scenes

In order to duplicate a scene simply select the scene 
and, on your keyboard, click Ctrl+D (or command+D on 
macOS).

2. CREATING A NEW SCENE

To create a new Scene you can go to the Scenes folder (Project > Assets > Scenes). In 
the folder, right click and choose Create > Scene.

After opening your new Scene, it is important to add all of the necessary 
components (see Scene Contents, p. 22), as well as the assets that you would like to 
include in you experiment.

These can be found in the Project Folder, at the following locations:
Project > Assets > System Prefabs
Project > Assets > Car Asset > Modified Car Asset > Car Prefabs
Project > Assets > HMI > Prefabs

To start building your own custom Scene you have two options: duplicating the 
existing Sample Scene or creating a new Scene to which you can add the necessary 
components.

1 Creating a New Scene

A Scene in Unity, is the space where you work with the content of the application. 
In the Scene, you must add all assets and components that are necessary, such as 
the environment and objects that are displayed, but also objects that contain scripts 
which allow the application for function as intended.

For an experiment you can create a single Scene, if you would like to show 
participants a single scenario, or multiple Scenes, for example, if you would like to 
expose participants to different HMI designs.

SCENE CONTENTS

Necessary Objects
These objects must be added to every 
Scene. With few exceptions, these 
objects and their children can remain 
unchanged. 

Flexible Objects
These objects can be removed from the 
scene or modified to fit the experiment. 

Note: When assets, such as prefabs and Timelines, are added to a scene, it is 
important to check that the necessary bindings between their components and 
other objects in the scene are recreated. See the notes on pages 15 and 21 for 
examples of bindings that are necessary in this Unity project.

Scenes Folder in the Project 
Window.

Watch the following video to see how 
this is done: Duplicating the Sample 
Scene 

( https://swov2.sharepoint.com/:f:/r/MEDIATOR/
Shared%20Documents/SWOV%20intern%20
-%20onderzoek/WP1/T1.5/Time%20budget%20
concept/Anna/User%20Manual%20-%20
Mediator%20VR%20Evaluation%20tool/Video%20
Tutorials?csf=1&web=1 )
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The position, rotation and scale of objects can be change in the transfrom component that is 
found in the inspector when selecting an object.
Using the gizmos on the screen, changes can be made directly by dragging the arrows and 
lines in the scene view.

Objects, 
including 
child objects, 
can be 
activated or 
deactivated 
at the top of 
the inspector 
window.
Deactivating 
an object 
will render 
it invisible in 
the scene.

2 Customising Scene Content

The Scene should contain all of the Mediator HMI components you might want to 
display during your evaluation. The first step in customising your Scene is deciding 
which HMI prefabs you would like to add or remove from your scene. All HMI 
component prefabs can be retrieved from (Project > Assets > HMI > Prefabs)

Next, you can decide to modify them to your linking.

Possible customisation:
• Changing an object’s position in the scene.
• Changing the size of an object.
• Activating of deactivating child components of the prefab.

Watch the following tutorial to get an overview of the ways in which 
you can customise your scene: Customising Scene Content_HMI 
prefabs 

( https://swov2.sharepoint.com/:f:/r/MEDIATOR/Shared%20Documents/SWOV%20
intern%20-%20onderzoek/WP1/T1.5/Time%20budget%20concept/Anna/User%20
Manual%20-%20Mediator%20VR%20Evaluation%20tool/Video%20Tutorials?csf=1&web=1 )

Note: In order to avoid the changes 
made to an HMI component to be 
saved to all of the instances of the 
HMI prefab across all of the project 
and in all scenes. It is important 
to remember to first Unpack the 
prefab completely, as shown in the 
image.
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3 Using the Unity Timeline

To animate the Mediator HMI components in the Scene and create various 
evaluation scenarios, we use the Unity Timeline. Several Timeline assets can 
be added to your scene and activated at different moments, to create complex 
scenarios within a single Scene. 

Follow the instructions in the next subsections to create a custom scenario in your 
Scene, using the Timeline tool.

ADDING TIMELINE ASSTES TO THE SCENE
The project includes a number of Timeline assets, representing the HMI in various 
driving modes and use cases, that can be added to the scene. These existing assets 
can be retrieved from the Project Folder: Project > Assets > Animations and 
Timelines > Timelines

Watch the following video to see how you can add these to your 
scene and create the necessary bindings: Adding Timeline Assets 
to the Scene
 
( https://swov2.sharepoint.com/:f:/r/MEDIATOR/Shared%20Documents/
SWOV%20intern%20-%20onderzoek/WP1/T1.5/Time%20budget%20concept/
Anna/User%20Manual%20-%20Mediator%20VR%20Evaluation%20tool/Video%20
Tutorials?csf=1&web=1 )

In order to add a Timeline asset to a 
scene, we must first create an empty 
gameObject in the Hierarchy window. 
This can be done by right clicking on 
an empty space in the Hierarchy and 
choosing Create Empty in the pop-up 
menu, as shown in the image on the 
right.

Next, we need to add the Playable 
Director component to the empty 
object from the inspector window (see 
image on the next page).

Finally, we can assign a Timeline 
asset to the Playable variable of 
the Playable Director component by 
selecting one, as shown on the next 
page, or by dragging it into the field from 
the Project window.

Right click in the Hierarchy window and 
select  “Create Empty” to add a new 

gameObject to the scene, which can house 
the Timeline asset

Select the new 
empty object 

and click “Add 
Component” 
button in the 

Inspector. Then, 
add the Playable 

Director 
component. 

Click the circular 
icon in the 
Playable variable 
field to select a 
Timeline asset 
from the ones 
existing in the 
project.

Note: After a Timeline asset is added its tracks must be linked to the animated 
objects in the Scene. See the note on page 21 and follow the instructions in 
order to create the necessary bindings.
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CONTROLLING TIMELINES
Once you have added the desired Timeline assets to your Scene, you must decide 
when and how they should be played during the evaluation. 
You can choose two methods to control the Timelines in your scene:

1. Timeline Controller - Wizard of Oz component: This is an object that can 
be added to the Scene, which includes a script that allows you to define which 
keyboard keys you can use to manually play (or pause) a Timeline during the 
evaluation. Each timeline will correspond to a single keyboard key.

2. Master Timeline: If you would like your Timelines to be played automatically in 
a specific order, you can arrange them on the time axis of a new Master timeline. 
By using the Control Track type, each timeline in the Scene will be played at the 
desired time.If you would like to manually activate the Timelines which you added to the Scene, 

drag the Timeline controller - Wizard of Oz prefab into the Hierarchy. You can 
retrieve this prefabs from: Project > Assets > System Prefabs

Next, you can set up the keys in the order which you would like to activate the 
Timelines. Adjust the length of the Triggers and Timelines list to fit the number 
of Timeline assets which you would like to activate manually (this can include a 
Master Timeline).

Finally, you can add your Timelines to the list, as shown in the next image. In the 
Triggers list, you must assign the keyboard inputs, which are created using 
Unity’s Input Action System. A number of keys for controlling the Timelines are 
predefined, see pages 35 and 38. If you would like to access more information about 
the Input Action System, please visit: https://docs.unity3d.com/Packages/com.unity.
inputsystem@1.0/manual/QuickStartGuide.html

Double click the 
number box and 
input a new number 
to edit the size of the 
list.
Click the circular 
icon of the list 
element to select a 
Timeline object.
Each element in the 
Triggers list affects 
the element of the 
same number in the 
Timelines list.

Note: Each input key selected in the Triggers list will affect the Timeline object 
that is added in the same position in the Timelines list.  

To set up a Master Timeline create an 
empty gameObject in the Hierarchy. 
Then, select the object and navigate to 
the Timeline Editor and click Create, 
as shown in the image on the left. You 
now have an empty Timeline.

Drag the other Timeline objects to the Editor, a new 
Control track will be created. Do this for all of the 
desired Timelines and arranged them on the time axis.

Note: To prevent the Timeline asstes 
to automatically play at the start of the 
application, make sure to untick the 
Play on Awake option in the Playable 
Director component.

Clicking the Create button 
will create a Timeline asset 
and add a Playable Director 
to the object that is selected.

In the following video you can see how to us each method and set up 
your timeline control: Controlling Timelines 

( https://swov2.sharepoint.com/:f:/r/MEDIATOR/Shared%20Documents/SWOV%20
intern%20-%20onderzoek/WP1/T1.5/Time%20budget%20concept/Anna/User%20
Manual%20-%20Mediator%20VR%20Evaluation%20tool/Video%20Tutorials?csf=1&web=1 )
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In the video you can see how Timelines can be modified to fit your 
experiment: Modifying Timelines and Animations 

( https://swov2.sharepoint.com/:f:/r/MEDIATOR/Shared%20Documents/SWOV%20
intern%20-%20onderzoek/WP1/T1.5/Time%20budget%20concept/Anna/User%20
Manual%20-%20Mediator%20VR%20Evaluation%20tool/Video%20Tutorials?csf=1&web=1 )

MODIFYING TIMELINES AND ANIMATIONS
If you would like to modify a Timeline, you can do so by playing with the position 
and duration of the Clips in the Timeline editor. For greater changes, you can also 
modify animation clips, or create new ones using the record function. 

Note: changes made to an existing Timeline asset will be automatically 
saved. To avoid overriding the existing asset across the entire project, you 
can duplicate it by selecting in the Project Folder and clicking Ctrl+D (or 
command+D on MacOS). 

Timelines are constructed of different tracks which define the animation of the 
various HMI objects existing in our Scene. On each we can add one or more 
Override tracks, these allow us to play multiple animation clips, of the same 
HMI object, at the same time. The two animations will merge together.

Animation clips can be positioned at any point on the 
timeline axis. We can extend an animation clip by clicking 
and dragging from the start or the end of a clip. This will 
extend the period in which the animation will play, being 
looped for the length of the clip. 

Different animation clips can be overlapped on the 
tracks. This will create a smooth transition between the 
two states.

If we wish to extend the time that a 
single loop will take to complete we 
must modify the Speed Multiplier 
variable in the Inspector window.

The post-extrapolate and pre-
extrapolate variables define what will 
happen before and after an animation 
clip is played in the Timeline. If we want 
our object to maintain the changes that 
are applied after the animation clip has 
ended we can select Hold on the post-
extrapolate variable. This will preserve 
the object in the state it is in on the last 
frame of the animation clip. If we select to 
Hold on the pre-extrapolate variable, the 
object will appear in the state of the first 
frame of the clip before it starts to play.

Animations can be recorded directly 
onto the Timeline asset and will look 
like the image below. By clicking the 
record button on each animation track 
and applying changes to the object 
linked to the track we can create new 
animations.

The Dashboard_LED animation track has two override tracks. The main track is used to define 
the color of the LED strip. The override tracks devine the pulsating effect and the lenght.

Visual representation of 
animation loops in the 
Timeline Editor.

one animation loop

Speed Multiplier and Animation 
Extrapolation options in the Inspector.

Two animation clips 
overlaping.

To record animations, press the highlighted 
record button. Recorded animations show 

keyframes on the timeline axis. Double clicking 
the track will open the animations window, 

where keyframes can be modified.

Keyframe

Visual representation of the Hold exrapolate 
option in the Timeline Editor. 

It will apprear before (pre-extrapolate) or 
after (post-extrapolate) the animation clip it 

is applied to.
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4 Building Evaluation Scenes

Once you have created all of the scenes required for your experiment, you must 
build the scenes onto the VR device.

Our project includes an object named Level Loader. This is an empty object to which 
we have attached a script that we can use to define a set of keyboard keys that will 
start the various Scenes we have built, during the evaluation. This component allows 
up to remotely start a Scene while a test participant is wearing the VR headset and 
be in control of the experiment.

In order for our Level Loader to work properly, we must set it up in the Inspector 
(selecting the Level Loader object) and in Unity’s Build Settings: File > Build 
Settings…

BUILDING THE PROTOTYPE
First, open the Build Settings window, as shown in the image below. In the Build 
Settings window we can see a list of “Scenes In Build”. Here, we can add the scenes 
in our project that we would like to use during our evaluation. 

On the right we can see that the lists are associated to numbers from 0 onward. This 

is the order of our built scenes. When starting the application on our device scene 0 
in the list will be the first to play.

Note: As you will notice in the image, the first scene that is added to out build 
list is the “Loading Scene (VR preparation)” scene. This is a scene that we will 
use to introduce the test participants to the VR experience and should always 
be included in your builds and it should always be placed as number 0 in the 
list.More information on the use of the loading scene in the next section of the 
User manual.

Once we have arranged our scenes in the desired order, we can verify  the remote 
controls, that will allow us to switch scenes by pressing specific keys on our 
keyboard, using the Level Loader prefab.

The script attached to this prefab 
contains a list of keyboard inputs, that 
allows us to activate various scenes 
in our list. Each input, corresponds 
to the scene that is positioned on 
the equilavent number in the Build 
Setting list.

Key inputs are defined using Unity’s 
Input Action System. Currently, scenes 
1 - 6 in the liscan be activate by 
pressing keys Q - Y, while scene 0 can 
de started by pressing Enter on they 
keyboard. (See page XX)

To learn more about the Input Action System and define new input keys for 
activating your scenes you can visit:  https://docs.unity3d.com/Packages/com.unity.
inputsystem@1.0/manual/QuickStartGuide.html
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5
Using the VR tool During the 
Evaluation Moment

1. INTRODUCE THE VR DEVICE

Before starting the evaluation we must introduce participants to the VR device, 
explaining how they can comfortably position it on their head and how to use the VR 
controllers to interact with the virtual environment.

The images below show the buttons which are used to perform interaction 
within the Mediator VR application on the controllers of the HTC Vive and Oculus 
Quest 2, the two platforms which were used in the development of this project.

If the participant’s position on the virtual car seat is not correct when they place the 
VR headset on their head, you must reset their starting position as shown below 
(for the HTC Vive) or instruct them on how to do it (for the Oculus Quest).

HTC Vive Pro

Press this button to Grip 
the Objects with your 
VR hands

This section includes a number of tips for the use of the Mediator VR Evaluation 
Tool, during the evaluation moment.
When using a VR device during an evaluation, it is important to take some time to 
prepare the test participants for the experience, as explained in subsections 1 
and 2.
In subsection 3, a short explanation of the Wizard-of-Oz controls is given, with cheat 
sheet of the existing keyboard controls.

Preview of 
the “Loading 
scene (VR 
Preparartion)

Press these buttons to Grip 
the Objects with your VR 

hands

Press this button for 3 
seconds to reset your 
position in the Virtual 

Environment

2. VR PREPARATION SCENE

When building our project it is important to remember to include the “Loading 
Scene (VR preparation)”, which, as the name suggests, is a scene that we use to 
introduce the test participants to the VR experience. 

In this scene, which include the vehicle, but none of the details related to the 
Mediator HMI design, participants can:

1. Adjust their headset to get comfortable in VR

2. Reset (or have it done by the researcher) their position in the virtual 
environment

3. Try out the interactions with the wheel and shifter.

Oculus Quest 2

Press this button 
on Steam VR 
to reset the 
participant’s 
position in 
the Virtual 
Environment
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Keys mapped to Load the Scenes 
according to the order deÞned in 
the Build Settings:
Q = Scene 1
W = Scene 2
...

Key to load the ÒLoading Scene (VR 
preparation), deÞned as Scene 1 in 
the Suild Settings.

Keys deÞned as ÒAnimation triggersÓ, which can 
be used in the Timeline Controller - Wizard of Oz 
object.

2. USING WIZARD-OF-OZ CONTROLS

The keyboard inputs witch are already setup in the project to trigger animations 
and load different Scenes, were briefly introduced on pages 30 and 35.
 
The image below shows a map of the keyboard, which you can use as a reference 
to help you and using the correct keys for the desired actions.

Keys used to load the Scenes 
according to the order defined in 
the Build Settings:
Q = Scene 1
W= Scene 2
E = Scene 3
...

Key to load the Loading Scene (VR 
preparation), defined as scene 0 in 
Build Settings.

Keys defined as “Animation triggers” which can 
be used in the Timeline Controller - Wizard of OZ 
object.

Author: 
Anna Aldea
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Experiment Introduction 

Thank you for taking part in this study. The purpose of this study is to validate the use the 
Mediator VR Evaluation Tool, as an effective tool in for the evaluation of the Mediator Human-
Machine-Interface.


In this experiment we look into the future, and imagine that you are in a self-driving car. The aim of 
self-driving cars is to take over the driving task from the driver. But, before they can do this 
completely and under any circumstance, there will be a time in which the drivers will use semi-
autonomous vehicles. While these vehicles are on the road a driver must be present at all times to 
take over the driving task when needed. The driver therefore has the task of supervising the 
automation and take control within seconds if requested by the automation. The degree of control 
the driver has over the autonomous vehicle at each time is dictated by the level of automation that 
is available. 

The Mediator system includes four driving modes, ranging from manual driving, during which the 
drive has full control of the vehicle, to highly automated driving, during which the driver is not 
required to motion the driving task for a specified amount of time.


The Mediator system is designed to inform the driver about the state of the automation (if it is 
capable of sustaining autonomous driving) and about the current level of automation and is 
designed to instruct the driver to give over or take over control of the vehicle as needed.


Please think back to the task that was given to you during the experiment: imagining yourself 
driving a semi-autonomous vehicle, monitoring the information given by the system and 
interacting with the system to give up control of the driving task.


On the following sheet, rate the MENTAL WORKLOAD that was required to perform the task 
described above.


Open questions after NASA-TLX questionnaire: 

Please elaborate on the given ratings. Which parts of the experience influenced the perceived 
mental workload of the task?


___________________________________________________________________________________


___________________________________________________________________________________


___________________________________________________________________________________


Extra background Information 

1. Have you ever experienced COMMERCIAL virtual reality systems? (circle one)


Yes / No


2. Do you have driving experience? If yes, please indicate the number of years of driving 
experience.


Yes / No                          Years: ________
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Please rate your experience of the VR application by ticking one of the circles on the seven 
point scale between the pairs of contrasting attributes. You can express your agreement with the 
attributes by ticking the circle that most closely reflects your impression.


This response would mean that you rate the application as more attractive than unattractive. 

Please decide spontaneously. Don’t think too long about your decision to make sure that you 
convey your original impression.

A third questionnaire was used for the final evaluation of 
the VR tool: the ICT-Sense of Presence Inventory (Lessit-
er et al., 2001). 

The questionnaire contains XX items related to the user’s 
experience with a form of media (interactive or non-in-
teractive). The items are divided into four factors: spa-
tial presence, engagement, ecological validity (or 
naturalness) and negative effects.

As the questionnaire cannot be publicly shared, an ex-
ample of one questionnaire item per each of the four 
categories will be given.

Spatial presence: “I felt I was visiting the placesin the dis-
played environment.”
Engagement: “I felt in-volved (in the displayed environ-
ment).”
Ecological Validity: “I had a strong sense that thecharac-
ters and objects were solid.”
Negative Effects: “I felt nauseous.”

Users must rate each item on a scale from 1-5, where 1 
is “highly disagree” and 5 is “highly agree”.
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Interview questions:

1. During the evaluation, did you ever feel like you were NOT able to experience the various 
parts of the Mediator HMI (LED strips, screens, gear, etc..) in a realistic way? If yes, what 
made the experience unrealistic?


 

2. During the evaluation, did you ever feel distracted from the subject of the evaluation (the 
Mediator HMI) and unable to understand what you were experiencing? If yes, what 
distracted you?


 

3. In your opinion, which aspects of the Virtual Reality application would need to be improved 
in order to increase your feeling of actually being inside a vehicle?


 

4. In your opinion, which aspects of the Virtual Reality application could be changed to 
improve the overall user experience? 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User Guide Evaluation Questions

Preliminary questions:

1. Are you familiar with or have you ever used the Unity Game Engine? If yes,
to what extent?

-2: I have never used Unity game engine
+2: I have used Unity game engine extensively in the past

-2 -1 0 +1 +2

O O O O O

2. Have you ever used the following types of applications: Game Engines
(other than Unity), video editing and animation creation, 3D modelling,
digital prototyping? If yes, to what extent and which ones?

-2: I have not use any of the above mentioned types of applications
+2: I consistently use  several similar applications

-2 -1 0 +1 +2

O O O O O

Applications used:  MATLAB
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Questionnaire:

1. I achieved what I wanted to achieve with the system
-2: Highly disagree
+2: Highly agree

-2 -1 0 +1 +2

O O O O O

2. The way the system worked was immediately clear to me
-2: Highly disagree
+2: Highly agree

-2 -1 0 +1 +2

O O O O O

3. The system was not complicated to use
-2: Highly disagree
+2: Highly agree

-2 -1 0 +1 +2

O O O O O

4. It was always clear to me what I had to do to use the system
-2: Highly disagree
+2: Highly agree

-2 -1 0 +1 +2

O O O O O

5. The information necessary to complete the task was easy to locate
-2: Highly disagree
+2: Highly agree

-2 -1 0 +1 +2

O O O O O

6. The information given in the user guide and video tutorials was clear
-2: Highly disagree
+2: Highly agree

-2 -1 0 +1 +2

O O O O O

7. I did not need additional information in order to complete the task
-2: Highly disagree
+2: Highly agree

-2 -1 0 +1 +2

O O O O O

Additional questions (follow-up interview):
1. Do you believe that the provided user guide and video tutorials are enough

to support you in creating a custom experiment? Why/who not?

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

2. In your opinion, what could be improved in the provided user guide and
video tutorials?

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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